Using ArcExplorer

ArcExplorer
Contents

1 Welcome to ArcExplorer
   What you can do with ArcExplorer
   What you need to install ArcExplorer
   How to install ArcExplorer
   How to get help when using ArcExplorer

2 Quick start tutorial
   The tool bars
   Exercise 1: Creating a map with data stored on your computer
   Exercise 2: Getting data from the Web
   Buttons for navigating a map

3 Adding Data to ArcExplorer
   Adding locally stored data to ArcExplorer
   Connecting ArcExplorer to an SDE database
   Spatial data formats you can use in ArcExplorer
   Viewing data on a Web site
   Downloading data off a Web site
   How data are downloaded
   Managing your ArcExplorer Web site list

4 Customizing the Map
   The legend
   Setting the map view display properties
   Creating MapTips
   Working with scale
   Setting scale factors
   Using an overview map

5 Symbolizing Data
   Using the Theme Properties dialog to symbolize your data
   Creating Single Symbol maps
   Unique Values maps
   Class Breaks maps
   Label maps
   Creating a No Overlapping Labels Map
Getting and Using the Attributes of Features     45
Identifying features with the mouse     46
Finding features by name     47
Finding features by building a query expression     48
Working with Query Results     49
More examples illustrating the syntax of query expressions     50
Generating summary statistics     51
Using the measure tool     52

Address Matching     53
How address matching works     54
What themes can be address matched     55
Preparing a theme for address matching     56
Locating a street address or intersection     57

Printing, Copying, Saving     59
Printing a map     60
Copying map views for use in other applications     61
Saving your work in ArcExplorer     62

Distributing Your Application     63
Creating relative path names for shapefiles or images     64
Creating relative path names for ARC/INFO coverages     65
Zipping up your ArcExplorer project and data     66

Customizing the Menu Bar and Tool Bars     67
ArcExplorer tool bars     68
Moving and undocking the menu bar and tool bars     69
Customizing the tool bars     70
Customizing the menu bar     71

Appendix     73
Welcome to ArcExplorer™, a geographic data explorer developed by Environmental Systems Research Institute, Inc. (ESRI). ArcExplorer is designed to dramatically change the way geographic data can be viewed and shared throughout organizations and the world. In a short time, you’ll be using ArcExplorer to view and query geographic data stored on your computer or on the Web. With ArcExplorer, the world of geographic data available on the Web is at your fingertips and can be easily put onto your desktop. You’ll be amazed at the ease with which you can take advantage of such useful tools as query, address match, measure, map creation, and so many more!
What you can do with ArcExplorer

Using maps to present and analyze geographic information is an ancient tradition. Today, the Web is our fastest and easiest means of distributing information. ArcExplorer links ancient tradition with modern technology by providing you with an easy solution for distributing geographic data. With ArcExplorer, one of the most pressing issues concerning geographic data and Web applications—how to distribute data openly and freely—is solved.

With ArcExplorer software’s suite of tools you can

• View and query ESRI® shapefiles, ARC/INFO® and PC ARC/INFO® coverages, and Spatial Database Engine™ (SDE™) layers.

• Display a wide variety of image formats.

• Address match (locate street addresses or intersections on a map).

• Measure distances on your map.

• Find features.

• Identify and query geographic and attribute data.

• Create maps using classifications, symbols, and labeling.

• Pan and zoom through multiple map layers.

• View and download data published on Web sites that use ESRI’s Internet Map Server (IMS) technology.

ArcExplorer also features legends, overview maps, saving and retrieving projects, and map printing.
What you need to install ArcExplorer

ArcExplorer is a Windows® desktop application. You must have Microsoft® Windows 95® or Microsoft Windows NT® 4.0 installed on your system in order to run ArcExplorer. If you are running Windows NT, you must have Service Pak 3 installed.

The ArcExplorer install program can be downloaded from the ArcExplorer home page www.esri.com/arcexplorer.

How to install ArcExplorer

You are now ready to install ArcExplorer.

If you already have an earlier version of ArcExplorer installed on your computer, we recommend that you uninstall it before running this install program. To uninstall, choose Add/Remove Programs from your Control Panel, choose ArcExplorer, click Add/Remove and follow the on-screen instructions for uninstalling ArcExplorer.

To begin installation, navigate to the install program, AEClient.exe, in the directory where you downloaded it from the Web.

Double-click the AEClient.exe file and follow the on-screen instructions.

Typically, you should choose all of the components when installing ArcExplorer. The following table describes the available components of the install program.

<table>
<thead>
<tr>
<th>Installation components</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Files</td>
<td>The core of the ArcExplorer software.</td>
</tr>
<tr>
<td>Help and Tutorial Files</td>
<td>Online help system and a copy of this document named ArcExplorer.pdf in the directory where ArcExplorer is installed.</td>
</tr>
<tr>
<td>Web Integration Tools</td>
<td>The World Wide Web (WWW) functionality of ArcExplorer. Choose these tools if you would like to view and download data from the Web using ArcExplorer.</td>
</tr>
</tbody>
</table>

After you’ve selected the desired components, follow the on-screen instructions to finish installation.
How to get help when using ArcExplorer

ArcExplorer has provided several ways for you to get help. In addition to this book, you can use ArcExplorer software’s online help system and ESRI on the Web to answer your questions.

The chapters in this book describe the tasks you can perform with ArcExplorer. This book also includes

- Quick Start Tutorial
- Frequently Asked Questions
- Troubleshooting Guide

What to read next

We recommend you begin learning ArcExplorer by working through the Quick Start Tutorial in the next chapter. It covers some common steps for viewing data and creating maps.

Getting online help

If you find you need more information about a specific option or procedure, use ArcExplorer online help.

Visit ESRI on the Web

ESRI home page

www.esri.com has up-to-date information on ESRI software and services.

ArcExplorer home page

www.esri.com/arcexplorer includes

- The latest information about ArcExplorer
- Current versions of this document’s Troubleshooting and Frequently Asked Questions sections

Be sure to check this site often for all the latest information on ArcExplorer.

ArcExplorer discussion forum

www.esri.com/arcexplorer gives all ArcExplorer users the opportunity to post questions and get answers about ArcExplorer issues with the entire ArcExplorer community.

ArcData Online

www.esri.com/data/online/ is ESRI’s Internet mapping and data site. ArcData™ Online provides a world of geographic data to create maps of your areas of interest.
This chapter serves as a quick introduction to ArcExplorer. It includes a description of the ArcExplorer window, listing of the tool bar buttons, and a quick start tutorial.

The tutorial guides you through some basic steps for getting data into ArcExplorer and creating a map. With ArcExplorer, displaying data and changing how they look is fast and easy. The tutorial exercises take you through viewing data stored on your computer and viewing data published on another Web site. It’s time to begin your first ArcExplorer session!
1. Menu Bar and Tool Bars—Used to access all the functions of ArcExplorer.

2. Legend—Displays all the layers of data as themes. The legend has two tabs: Local for managing locally stored data and WWW for managing data on Web sites.

3. Map View—Displays the data.

4. Scale Bar—Displays the scale of the current map view.

5. Cursor Position Window—Shows the geographic position of the cursor on the map view in your data's map units.

6. Overview Map—Displays an overview map showing the full extent or half the extent of your data, with a red box outlining the area displayed in the map view.

7. Status Bar—Shows help messages on the left and lists the current active theme on the right.

All features except the scale bar and overview map are present when you start ArcExplorer for the first time.
# The tool bars

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>New ArcExplorer</td>
<td>Starts a new session of ArcExplorer.</td>
</tr>
<tr>
<td></td>
<td>Open Project</td>
<td>Opens an ArcExplorer project (file with an .aep extension). (Local mode only.)</td>
</tr>
<tr>
<td></td>
<td>Save Project</td>
<td>Saves an ArcExplorer project. (Local mode only.)</td>
</tr>
<tr>
<td></td>
<td>Close Project</td>
<td>Removes all themes and returns an empty view. Closes the Web map site in WWW mode.</td>
</tr>
<tr>
<td></td>
<td>Add Theme(s)</td>
<td>Adds one or more theme(s) to the view. Adds a Web map site in WWW mode.</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>Prints the map view and legend to a preformatted map layout. (Local mode only.)</td>
</tr>
<tr>
<td></td>
<td>Toggle ArcExplorer Legend</td>
<td>Toggles the legend on and off.</td>
</tr>
<tr>
<td></td>
<td>AEWeb Favorites</td>
<td>Opens the AEWeb Favorites dialog.</td>
</tr>
<tr>
<td></td>
<td>Cancel WWW Request</td>
<td>Cancels a request to a map server for a download of WWW data.</td>
</tr>
<tr>
<td></td>
<td>Retrieve Data from WWW</td>
<td>Downloads data displayed in the map view from WWW.</td>
</tr>
<tr>
<td></td>
<td>Zoom to Full Extent</td>
<td>Zooms to the extent of all themes.</td>
</tr>
<tr>
<td></td>
<td>Zoom to Active Theme</td>
<td>Zooms to the extent of the active theme. (Local mode only.)</td>
</tr>
<tr>
<td></td>
<td>Zoom to Previous Extent</td>
<td>Zooms to the last previous extent. (Local mode only.)</td>
</tr>
<tr>
<td></td>
<td>Zoom In</td>
<td>Zooms in on the position you click or the box you drag on the map view.</td>
</tr>
<tr>
<td></td>
<td>Zoom Out</td>
<td>Zooms out from the position you click or the box you drag on the map view.</td>
</tr>
<tr>
<td>Button</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>🧵️</td>
<td>Pan</td>
<td>Pans the map as you drag the mouse across the map view.</td>
</tr>
<tr>
<td>🧵️</td>
<td>Direction</td>
<td>Choose panning directional</td>
</tr>
<tr>
<td>🧵️</td>
<td>Pan North</td>
<td>Pans the map view to the north.</td>
</tr>
<tr>
<td>🧵️</td>
<td>Pan South</td>
<td>Pans the map view to the south.</td>
</tr>
<tr>
<td>🧵️</td>
<td>Pan East</td>
<td>Pans the map view to the east.</td>
</tr>
<tr>
<td>🧵️</td>
<td>Pan West</td>
<td>Pans the map view to the west.</td>
</tr>
<tr>
<td>🧵️</td>
<td>Identify</td>
<td>Lists attributes of features you identify by clicking them in the map view.</td>
</tr>
<tr>
<td>🧵️</td>
<td>Find</td>
<td>Finds a map feature(s) based on a text string you type in. (Local mode only.)</td>
</tr>
<tr>
<td>🧵️</td>
<td>Query Builder</td>
<td>Queries the active theme based on a query expression you construct.</td>
</tr>
<tr>
<td>🧵️</td>
<td>MapTips</td>
<td>Displays attribute information for features on the map view. (Local mode only.)</td>
</tr>
<tr>
<td>🧵️</td>
<td>Measure</td>
<td>Measures distances on the map view. You must first choose measurement units from the detachable menu.</td>
</tr>
<tr>
<td>🧵️</td>
<td>Address Match</td>
<td>Locates a street address or intersection on the map view.</td>
</tr>
<tr>
<td>🧵️</td>
<td>Clear Thematic Classification</td>
<td>Removes thematic classification from the active theme. (Local mode only.)</td>
</tr>
<tr>
<td>🧵️</td>
<td>Clear Selection</td>
<td>Clears the selected/highlighted features from the map view. (Local mode only.)</td>
</tr>
<tr>
<td>🧵️</td>
<td>Theme Properties</td>
<td>Sets the display characteristics of the active theme. (Local mode only.)</td>
</tr>
</tbody>
</table>
Exercise 1: Creating a map with data stored on your computer

In order to perform these exercises, you should have installed ArcExplorer and the tutorial files. If you did not modify the components included in the standard installation, you will find the tutorial files under Program Files\Esri\ArcExplorer in the AETutor folder. If you do not have a computer, you may wish to read through the exercises to gain a basic understanding.

IN THIS EXERCISE

- **Start ArcExplorer and open the tutorial project.**
- **Change the name and color of themes.**
- **Add an overview panel.**
- **Use the Find tool.**
- **Label a theme.**
- **Print, save, and close a map.**

1. Start ArcExplorer. You will see the ArcExplorer opening banner then the ArcExplorer window.

2. Click the Open Project button.

   **Project.** A file in which you store the work you do with ArcExplorer. A project contains the path names to the data used in the application plus information on how the data are being displayed. In this way, your work is stored in one convenient place. Project file names have an .aep extension.

3. In the dialog that appears, navigate to the location of the directory named AETutor. Open the AETutor directory. You have an ArcExplorer project called qstart.aep.

4. Select the project filed called qstart.aep and click Open.

5. Double-click on the name of the LAKES theme in the legend to open the Theme Properties dialog.

Map view. A map of the United States is drawn in the Map View. The map view is made up of themes of geographic information for a particular area or place. Each theme is a collection of geographic features such as rivers, lakes, countries, or cities.

Legend. All themes in a map view are listed to the left of the map in the legend. The legend shows the theme name and the symbol used to draw each theme. The check box next to each theme indicates whether it is currently turned on or off in the map view, that is, whether it is currently drawn on the map or not.
Click the Color box, choose a shade of blue, and click OK. Then click OK to close the Theme Properties dialog.

Click the check box next to LAKES to display the LAKES theme on your map.

The STATES1 theme and the STATES (STATE_NAME) theme represent the same features, the state boundaries for the United States, but they display different information about these features. When two or more themes of the same name are added, ArcExplorer adds a number to the end of the name so the themes can be distinguished from each other. The STATES1 theme will be displayed with labels, so let’s change the name of theme.

Double-click the STATES1 theme to open the Theme Properties dialog. In the Theme name box at the top of the dialog, highlight the name STATES1 and replace it with STATE LABELS. Click OK to close the Theme Properties dialog.

In the legend, uncheck the box for the theme called STATE LABELS to turn it off in your map view.

Check the box for the theme called STATES (STATE_NAME) to turn it on.

The STATES (STATE_NAME) theme is displayed with a unique values classification. In a unique values map, a different color is used to symbolize each value for a specified field. In this example, the field STATE_NAME is used to display each state in a different color.

From the View menu, choose Overview. You have added an overview panel in the lower left corner of the ArcExplorer window.

Right-click on the theme STATES (STATE_NAME) and choose Display Thematic Classification to hide the thematic legend. Notice how the legend has changed but the display in your map view remains unchanged.

Right-click on the theme WORLD and choose Use in Overview Map. The world countries theme now draws in a dark green color in the overview panel.

You can use the Find tool to perform quick searches on your data. Click the Find tool.
You want to locate the State of Illinois. In the Find dialog, enter Illi. The search type should be set to Any Part of Field.

Choose STATES (STATE_NAME) as the theme to search and click Find. (The theme name appears as STATES.)

You should see Illinois appear in the lower panel of the Find dialog. Click the found feature then click Highlight. The state of Illinois should flash.

Click Zoom To and the extent of your map changes to the State of Illinois.

Close the Find dialog.

Double-click on the name of the STATE LABELS theme in the legend to open the Theme Properties dialog.

As your final step, you will add labels to your map. Choose Standard Labels.

For the Text Field, choose STATE_NAME.

Uncheck the Draw Features box. This will draw the labels without the features.

Click OK to commit your changes and close the Theme Properties dialog.

Turn on the STATE LABELS theme. The labels for the state names are drawn on your map.
Now that you have created a map, you can print it. Click the Print button.

Type “Map of Illinois” as the title for your map. Choose a printer and click Print.

Choose Save As from the File menu. Save the project under Program Files\Esri\ArcExplorer\Tmp and name your project Illinois.

Click the Close Project button to close your newly created Illinois.aep.
Exercise 2: Getting data from the Web

IN THIS EXERCISE

• Open the ESRI ArcExplorer Web site.
• Use the zoom tools to locate Sydney, Australia.
• Retrieve data from the ESRI ArcExplorer Web site.
• View data that have been retrieved from the Web.

WHAT YOU NEED

WWW Access: ArcExplorer WWW access assumes that you have a valid Win32 Internet connection. ArcExplorer makes a connection using the default parameters as defined in the Windows Registry by the WWW provider software. Check with your Web administrator if you have questions regarding your Web access.

1. If ArcExplorer isn’t already running, start it. Click the WWW tab at the top of the legend to switch to the Web mode.

2. Click the Add Theme(s) button to open a Web site.

3. Choose ESRI ArcExplorer Web Site and click Add URL.

ESRI ArcExplorer Web site. ESRI maintains a Web site of geographic data for you to view and download. The ArcExplorer Web site provides USA and world basemap data. When you first open the site, the extent of the data is an overview of the entire United States or world. As you zoom to a particular area, more layers of detailed data, such as country boundaries, city points, rivers, roads, railroads, and airports, are displayed.

4. Under AEWeb in the legend, you see USA BaseMap and World BaseMap. Click World BaseMap to open the world data theme.

5. For this exercise, you need to display Sydney, Australia. You can use the Zoom In tool to change the map extent. Click the Zoom In tool.

6. Drag a box over southeastern Australia: position the cursor where you want one corner of the box to be, hold down the left mouse button, drag the mouse until the box outlines the area you want to zoom in on, then release the mouse button to finish. The view redraws to show you the area in the box you defined.

7. As you zoom in, layers of more detail draw. Once you have zoomed in to eastern Australia, you should be able to see Australia’s capital, Canberra. Continue to use the Zoom In tool until you have an extent that shows the City of Sydney. (Sydney is on the eastern coast north of Canberra.)
Buttons for navigating a map

- **Zoom to Full Extent button.** Zooms to the full spatial extent of all the themes in your view. For example, if you have zoomed in a couple of times on your view, click this button if you want to see the whole view again.

- **Zoom to Active Theme button.** Zooms to the spatial extent of the active theme in your view. The themes in a view often have different spatial extents. Some themes may represent features located all over the map, while others may represent features found in particular areas on the map. With this button you can easily zoom in on the area covered by a particular theme that interests you. Before you click this button, click the name of the theme in your legend that you wish to zoom to. This will make that theme active. (Local mode only.)

- **Zoom to Previous Extent button.** Goes back to the previous spatial extent you were viewing. Click this button to go back to where you were before you zoomed or panned. (Local mode only.)

- **Zoom In button.** To zoom in on a particular position on the view, click that position once with this tool. To zoom to a particular area on the view, drag a box over the area with this tool.

- **Zoom Out button.** Same as the Zoom In tool but zooms out from the position you click or the area you drag over.

- **Pan button.** Lets you pan the view by dragging the display in any direction with the mouse. To pan, click this tool, move the cursor anywhere over the view, hold down the mouse button, and drag in any direction. Release the mouse button to leave the view in your desired position. When you are zoomed to the full extent of all themes, the Pan button is not enabled.

- **Direction button.** The direction button is a detachable button bar with the following button options. Click a button and the view pans in the chosen direction.
  - Pan North
  - Pan South
  - Pan East
  - Pan West
Once you have Sydney displayed, click the Retrieve Data from WWW tool.

On the Retrieve Options dialog, click Retrieve to download data for the current extent.

Accept the license agreement.

Choose or create a folder to download the data to and click the Open button.

After the data are done downloading, click Yes to add the data to your local map view.

Now you can view the data that have been added to your local map view.

Your ArcExplorer project is now named default.aep. When shapefiles are downloaded from the ESRI ArcExplorer Web site, an ArcExplorer project called default.aep is included. This is useful because an ArcExplorer project named default.aep can be included in a ZIP archive to be dragged and opened in ArcExplorer. The next chapter discusses adding data to your ArcExplorer project.

You now have a clipped extent of all the themes that you were viewing in WWW mode. At this point you have simply downloaded the data into your map view. In later chapters, you will see how to change the display of themes and your map view properties to create attractive maps.

From the File menu, choose Exit.

We hope you've enjoyed this tutorial and found it a useful introduction to some of the main ways you can use ArcExplorer. You can learn more about ArcExplorer by reading the other chapters in this book. Each chapter describes a particular task you can perform with ArcExplorer.
In the previous chapter, the Quick Start Tutorial, you saw how to work with maps that have already been prepared. You opened an existing ArcExplorer project and worked with the map contained in that project. This chapter shows you how to add your own data into ArcExplorer.

ArcExplorer software’s key functionality is the viewing of spatial data. This chapter shows you how to view data that are stored on your computer or published on a Web site.
Adding locally stored data to ArcExplorer

ArcExplorer has two modes for loading and viewing data: Local and WWW. You can switch between Local and WWW mode by clicking the tabs at the top of the ArcExplorer legend. In Local mode, you can access data stored on your computer or other computers connected to your computer via a network or an ESRI SDE server.

1. Click the Add Theme button to open the Add Themes dialog.

2. For Data Types, choose the type of data you want to load from All ArcExplorer Types, Shapefiles ARC/INFO Coverages, Supported Images, or ZIP Archives. Or choose All Other Formats to see all files stored in a directory. See the appendix for a list of image formats you can use with ArcExplorer.

3. Click on each directory to navigate to the directory where your data are stored.

4. Click the file you wish to add.

5. Click Add Theme.

6. Navigate to another directory to add additional themes, or click Close to close the Add Themes dialog. The themes you chose appear in the legend.

Shortcuts for adding data to ArcExplorer

From the Add Themes dialog, you can
- Double-click a file to add it as a theme
- Drag and drop a file directly into the map view.
This drag and drop functionality also works by dragging a file from your Windows Explorer into a map view.

Displaying annotation

Adding a coverage to ArcExplorer that has annotation is a two-step process. First, add the ARC/INFO or PC ARC/INFO coverage or SDE layer that contains the annotation to your ArcExplorer project. Then, double-click the theme to open the Theme Properties dialog. Choose Standard Labels and select the text field that contains the annotation value. Click OK to dismiss the Theme Properties dialog. Turn on the theme to display the annotation. See Chapter 5, Symbolizing Data for a complete discussion on how to use the Theme Properties dialog to display labels.
Connecting ArcExplorer to an SDE database

ArcExplorer recognizes data stored in an SDE database. Before you can add an SDE layer to ArcExplorer, you must have an SDE client installed on your system. Consult with your SDE administrator if you are not sure if your system is set up to connect to an SDE database. If necessary, your SDE administrator will provide you with the SDE instance information needed to edit your Windows Services file.

WHAT YOU NEED

- An SDE client installed on your system

1. Choose Add SDE Theme from the Theme menu.

2. Enter the name of the SDE Server, Instance, User, and Password and click Connect. (Uncheck the SDE Version 3.0 box if the SDE database is Version 2.x.)

3. Highlight the SDE theme you want and click Add.

4. Click Close to close the Connect SDE Theme dialog. The theme(s) from the SDE database appear in the legend.

Sybase and SQLServer users

To specify a database other than the default, in the Instance box, specify instance:database name, for example, esri_sde:star.

Disconnecting from an SDE database

When you want to disconnect from an SDE database, choose Remove Theme from the Theme menu and remove any SDE themes from your ArcExplorer project. Then return to the Connect SDE Theme dialog and click Disconnect. Otherwise, an SDE database is disconnected when you exit ArcExplorer.
Spatial data formats you can use in ArcExplorer

Maps in ArcExplorer are based on spatial data. Spatial data are data containing the geographic location of features on the earth’s surface, along with attribute information describing what these features represent.

Spatial data are at the heart of every ArcExplorer project. Here are the spatial data formats you can use in ArcExplorer:

**ArcView GIS shapefiles**

Shapefiles are a simple, nontopological format for storing the geometric location and attribute information of geographic features. An ArcView® GIS shapefile is one of the spatial data formats you can work with in ArcExplorer. You can drag and drop any one of the three shapefile extensions (see below) from a Windows directory directly into an ArcExplorer Map View to add that shapefile as a theme.

The shapefile format defines the geometry and attributes of geographically referenced features in as many as five files with specific file extensions that should be stored in the same project workspace. They are

1. **.shp**—the file that stores the feature geometry.
2. **.shx**—the file that stores the index of the feature geometry.
3. **.dbf**—the dBASE file that stores the attribute information of features. When a shapefile is added as a theme to a view, this file is displayed as a feature table.
4. **.sbn** and **.sbx**—the files that store the spatial index of the features. These two files may not exist until you perform theme-on-theme selection, spatial join, or create an index on a theme’s shape field in another ESRI software. ArcExplorer recognizes these file extensions but cannot create them.

**ARC/INFO coverages**

ESRI’s ARC/INFO is a GIS program for handling, managing, and analyzing geographic information. With ArcExplorer, you can access spatial data stored in ARC/INFO format including data created from PC ARC/INFO.

An ARC/INFO coverage can contain more than one class of geographic features. For example, a coverage containing area features, such as land parcels, may also contain line features that store information about the boundaries between the parcels. When you add an ARC/INFO coverage containing more than one feature class to a view, you choose which feature class you want the theme to represent. This is because a theme can only represent one class of features from a coverage. However, you can add several themes to a view each based on a different class of features from the same ARC/INFO coverage.
Spatial Database Engine layers

ESRI’s Spatial Database Engine (SDE) is a high-performance, object-based spatial data access engine implemented in several commercial relational database management systems using open standards and true client/server architecture. SDE is chosen as a means of storing an extremely large number of features in a continuous database.

ZIP archives

ArcExplorer supports the ZIP and SHIP functionality of the Internet. You can add ZIP archives directly to an ArcExplorer project. ArcExplorer unzips ZIP archives into the folder you choose or create. ArcExplorer unzips shapefiles, supported images, and ArcExplorer projects named default.aep; all other file formats in a ZIP archive will be ignored by ArcExplorer.

If the ZIP archive contains an ArcExplorer project named default.aep, it will be opened when the ZIP archive is added to ArcExplorer. If you unzip a ZIP archive of shapefiles into a folder that already contains shapefiles, all shapefiles in that folder will be added to ArcExplorer.
Viewing data on a Web site

The World Wide Web has become one of our most important resources for information exchange. For many users, downloading data from the Web is a common task. For example, you probably obtained the ArcExplorer installation program by downloading it from the Web. ArcExplorer has its own Web integration tools for viewing and downloading geographic data from the Web.

ArcExplorer users can view and download geographic or spatial data from Web sites that employ ESRI MapObjects™ Internet Map Server (IMS) technology. Check out the ArcExplorer home page www.esri.com/arcexplorer for information on how to use ESRI’s IMS technology to create a Web site for spatial data.

ESRI maintains its own Web site of geographic data that ArcExplorer can access. The Universal Resource Locator (URL) to use in your connection is nutria.esri.com/scripts/esrimapc.

WHAT YOU NEED

WWW Access: ArcExplorer WWW access assumes that you have a valid Win32 Internet connection. ArcExplorer makes a connection using the default parameters as defined in the Windows Registry by the WWW provider software. Check with your Web administrator if you have questions regarding your Web access.

1. At the top of the legend, click the tab labeled WWW.

2. Click the Add Theme button.

3. Here you type in the URL of a Web site you wish to view data from. The first time you use ArcExplorer, ESRI ArcExplorer Web Site is listed. The ESRI ArcExplorer Web Site is already saved as an AEWeb Favorite.

4. Click the Add URL button.

5. If you have entered a URL other than ESRI ArcExplorer Web Site, ArcExplorer prompts you to save the URL as one of your AEWeb Favorites. You can choose Yes to save the URL and then enter a name for this new AEWeb Favorite, or choose No to open the URL without saving it as an AEWeb Favorite.

6. The name of the data server appears under AEWeb. Navigate through the directory of available data and click the data you want to add to the map view. A legend listing all the Web-based themes appears below the directory. Use the black and gray arrows to scroll through the list if it extends beyond the legend panel.

To close a Web site
Select a site in the AEWeb treeview. Click the Close WWW Map Site button.
Adding data to ArcExplorer

Adding data to ArcExplorer

The previous section described viewing data on the Web in ArcExplorer while the data remained on the Web server. ArcExplorer not only gives you the capability to view data, but you can also download spatial data from the Web. The spatial data can be downloaded from the Web onto your computer in a format usable with ArcExplorer.

WHAT YOU NEED

WWW Access: ArcExplorer WWW access assumes that you have a valid Win32 Internet connection. ArcExplorer makes a connection using the default parameters as defined in the Windows Registry by the WWW provider software. Check with your Web administrator if you have questions regarding your Web access.

WHAT YOU NEED

Once you are viewing data on the Web that you would like to have locally, use the Pan and Zoom tools to display the extent of data to be downloaded.

Once you are satisfied with the extent, click the Retrieve Data from WWW tool. At this point, ArcExplorer is attempting to connect to the map server, the machine that is serving the data. You can stop this search by clicking the Cancel WWW Request tool. Once ArcExplorer has located the map server, this button is disabled.

Choose the extent of data you want and click Retrieve.

Accept the License Agreement (if applicable).

Choose or create the folder where you want the data to be stored and click Open.

ArcExplorer starts downloading the data. You can halt the download of the data by clicking the Cancel button on the Retrieve Options dialog.

Once ArcExplorer has finished downloading the files to your local drive, you will be asked if you want to add the data to your local map view. If you choose No, the files are stored at the location where you specified. If you choose Yes, the themes are added. Click the Local tab at the top of the legend to use the new themes.
How data are downloaded

ArcExplorer downloads data for the themes listed in the legend, regardless of whether that theme is turned on or not.

Depending on what the Web site is providing, the data can be in vector or raster data format. Vector data are data composed of lines, areas, or points; raster data are images composed of pixels. Each vector data theme is downloaded as a shapefile; each raster data theme is downloaded into a bit map.

A Web administrator publishing spatial data on a Web site controls what data are allowable for downloading. When you attempt to download data, one of the following setups will be available to you. Look for the corresponding icon under the AEWeb tree to determine which setup is available for a Web site.

- You will get data that the Web administrator has allowed for downloading.
- You will be directed to an alternate Web site that has been provided for data downloads.

or

No data downloads are allowed for that Web site.
Managing your ArcExplorer Web site list

Just as you would save bookmarks or favorites using your Web browser, ArcExplorer allows you to save AEWeb Favorites. Save a Web site that you plan on visiting frequently as an AEWeb Favorite for quick access next time you want to go to it.

You can add, open, delete, or edit an AEWeb Favorite by clicking the AEWeb Favorites button.

WHAT YOU NEED

WWW Access: ArcExplorer WWW access assumes that you have a valid Win32 Internet connection. ArcExplorer makes a connection using the default parameters as defined in the Windows Registry by the WWW provider software. Check with your Web administrator if you have questions regarding your Web access.
The last two chapters have taken you through the steps for adding data to ArcExplorer. The adding and viewing of data describes ArcExplorer software’s key functionality. Now that you have become familiar with ArcExplorer, this chapter introduces the ArcExplorer interface to you in more detail. Terms used throughout this book referring to the interface are defined in this chapter. This chapter also has steps for making changes to the display properties of the map.

- How to use the legend
- How to set the map view properties
- How to create MapTips for your display
- How to add a scale bar to your map
- How to add an overview map
The legend

All themes in a map view are listed to the left of the map in the legend. The legend shows the theme name and the symbol used to draw each theme. The check box next to each theme indicates whether it is currently turned on or off in the map view, that is, whether it is currently drawn on the map or not.

The order in which the themes are listed in the legend is also important. The themes at the top of the legend are drawn on top of those below it. Themes that form the background of your map are listed at the bottom of the legend. To change the order a theme is drawn in, drag the theme up or down in the legend.

You can change the width of the legend by dragging the border between the legend and the map either left or right. This is useful if you want to increase the width of the legend so that you can see long theme names.

The legend has two tabs: Local for managing locally stored data and WWW for managing data stored on Web sites.

Click the check box to the left of each theme’s name to make the theme draw in the map view. Clicking again will turn the theme off.

Make a theme active by single clicking on its name in the legend. Many operations work only on active themes. When a theme is active, it appears raised in the legend.

Use the black and gray arrows to scroll the legend up and down if there are more themes loaded than can be shown.
Right-click a theme in the Local legend.

Double-click a theme in the Local legend.
Setting the map view display properties

You can control the background color, map outline, scroll bars, and other characteristics of your map view. Map display properties can only be set in Local mode.

1. Choose Map Display Properties from the View menu.

2. Check the Scrollbars on map box if you want the map view to include scroll bars at the edge of the map for panning. (This option has no effect on the standard pan and zoom tools.)

3. Check the 3D appearance box if you want the map view to have a slightly raised effect.

4. Check the Border style box if you want to enhance the border around the map view.

5. Set a background color for the map view by clicking on the Background box and clicking the desired color.

6. Change the color for highlight by clicking the Highlight box and choosing a desired color. Features found in a query are highlighted in this color.

7. Set the Escape key to cancel an action. You can set it to stop drawing all layers, to stop drawing the current layer, or to do nothing.
Creating MapTips

MapTips are small popups that display data for a field you specify. MapTips work on the active theme as you move the cursor over the features on the map view. (MapTips only work in Local mode).

1. Make the theme you want to display MapTips for active.

2. Click the MapTips tool to display the MapTips dialog.

3. Choose the field to be displayed in the MapTips and click OK.

To use MapTips for a theme

Move your mouse over features on the map view to display MapTips.

To disable MapTips

Click the Clear button on the MapTip Field Selection dialog.
Working with scale

Each time you zoom in, zoom out, or resize a map view, the scale changes. ArcExplorer reports this change on the scale bar.

The scale bar consists of a representative fraction (1:24,000), a rule with distance markers, and an equation (one inch = 40 miles). The fraction (RF scale) is a common way to present scale in cartography and can be read as “one inch on the screen is equal to 24,000 inches on the ground.” The equation (sometimes referred to as a “verbal scale”) presents the same information but translates the single unit (an inch in this example) into a unit you’d use when getting around in the real world (e.g., miles).

To add a scale bar to the map view

1. Choose Display Scale Bar on the View menu to add a scale bar.

2. Right-click the scale bar and set the map, scale, and screen units.

Map units

Map units are the units in which geographic data are stored. Because there are a variety of data collection and storage methods, it is impossible for ArcExplorer software to determine exactly which type of map unit is used with your data. Because of this, you must select the proper map units for accurate scale bar measurements. ArcExplorer defaults to decimal degrees, but this could be wrong and provide erroneous results on the scale bar if your data are stored in feet or meters. If you don’t know the map units for your geographic information system (GIS) data, read your data documentation or speak to the person who gave you the data. If you can’t find this information, you can zoom into a familiar area and try all three map units choices until you get one that seems to provide the most accurate results. You can set the map units as decimal degrees, feet, or meters.

Scale units

Scale units display in the scale bar itself and in the right side of the verbal scale equation (e.g., 1 centimeter = 200 kilometers). You can set the scale units as miles, feet, meters, or kilometers.

Screen units

Screen units correspond to the actual display on your computer monitor and are presented on the left side of the verbal scale equation (1 inch = 40 miles). You can set the screen units as either inches or centimeters.
Setting scale factors

You can control the scale at which a theme displays by setting its scale threshold. For example, you could set a U.S. state boundaries theme to turn off after you zoom past a certain point, and set the county boundaries to turn on at the same scale. Setting up scale dependencies can help keep the map display clean and focused on relevant data.

1. Use the zoom tools to set an extent for your display.

2. Right-click the theme’s name.

3. Choose Set Minimum Scale Factor if you want the theme to turn off if you zoom in any closer. Choose Set Maximum Scale Factor if you want the theme to turn off when you zoom further out.

To Remove Scale Factors

If you want to get rid of the scale factors, right-click the theme’s name and choose Remove Scale factors to remove any previously set scale factors.
Using an overview map

The overview map displays the full or partial extent of a theme with a red box outlining the current extent of the map view. A full or partial extent is displayed depending on how far you have zoomed in. Overview maps are available in Local mode only.

1. Check Overview from the View menu to add an overview panel.

2. Choose a theme to display in the overview map. Typically, a theme showing boundaries or the extent of your study area, such as world country boundaries, is used in the overview map. Only one theme can appear in the overview at a time.

3. Right-click on the theme and choose Use in Overview Map.
Other ways to add a theme to the overview map

• Hold down the Control key while using the right mouse button to drag and drop the theme from the legend into the overview map.
• Use the middle mouse button to drag and drop the theme from the legend into the overview map.
You can communicate complex information more effectively using maps than with tables or lists because maps take advantage of our natural abilities to distinguish and interpret colors, patterns, and spatial relationships. When you display your data on a map you’ll see distributions, relationships, and trends that you couldn’t see before. Maps help you to effectively communicate your information and results to others.

Choosing how to represent your data on a map may well be your most important mapmaking decision. Symbolizing your data involves choosing colors and symbols that will represent features. It also involves grouping or classifying features according to their attribute values.

This chapter shows you how to create attractive maps and use symbolization as a powerful tool for exploring, understanding, and analyzing your data.
Using the Theme Properties dialog to symbolize your data

Use the Theme Properties dialog to control how each theme is drawn in the map view. For each theme, the Theme Properties dialog lets you choose:

- If you want to classify the theme’s features, display all the features with the same symbol, or label a theme
- The attribute the theme’s features are classified on
- The method of classification
- A color scheme for the classification
- How a theme is labeled

1. Make a theme active and click the Theme Properties button or double-click a theme’s name in the legend. The Theme Properties dialog is displayed.

In the Theme Properties dialog, the Theme name field shows you the theme you are working with. The Classification Options show you what type of legend this theme is currently displayed with. In this example, the classification option is Single Symbol, which means that all the features in the theme are currently drawn with the same symbol (the symbol shown in the dialog).

The Theme Properties dialog changes to reflect which classification option you have chosen. The following sections show you how to create a Single Symbol, Unique Values, Class Breaks, or Label map.
Creating Single Symbol maps

The Single Symbol classification displays all the features in the theme with the same color and style. When you add a theme to ArcExplorer, it is displayed as Single Symbol maps.

1. Open the Theme Properties dialog.

2. Click the Color box to change the color or to create a custom color.

3. Click the Style box to change the symbol's style.

4. Enter a Size value for line width, outline width, or marker size depending on whether your theme's feature type is line, area, or point.

5. Click Apply to commit your changes or OK to commit the changes and close the Theme Properties dialog at the same time.

Labeling a theme classified as Single Symbol

In order to label a theme that has a Single Symbol classification, open the Theme Properties dialog and first choose the Single Symbol classification. Then choose either Standard Labels or No Overlapping Labels and set the labels for the theme.
Unique Values maps

The Unique Values classification displays features by applying a different color to each unique value for a specified field. In the example shown below, a map of U.S. counties displays the counties of each state in a separate color.

1. Open the Theme Properties dialog.

2. Choose Unique Values from the Classification Options.

3. Choose a Field (e.g., STATE_NAME).

4. ArcExplorer automatically assigns random colors to each unique classification. You can click a color box to change a value’s color.

5. Check the Remove Outline box if you want polygons drawn with no outline. (This is useful when you have many small polygon features.)

6. Click Apply to commit your changes or OK to commit the changes and close the Theme Properties dialog at the same time.

To remove classification from the active theme
Click the Clear Thematic Classification tool to return the theme to Single Symbol classification.

To highlight features from the legend
Once you’ve set up a Unique Values map, click a colored box in the legend to highlight the corresponding features on the map.

To clear highlighted features
Click the Clear Selection button to remove a highlighted feature from the map view. A highlighted feature remains on the map view, even after you turn the theme off, until you click the Clear Selection button.

To label a theme classified as Unique Values
In order to label a theme that has been thematically classified, you must add the theme twice, once with its thematic classification and then again to label it.

1. Add that theme to your legend twice.

2. Set the second theme as a Label map. Uncheck the Draw Features box. Click OK.

Be sure the labeled theme is listed on top of the other theme in the legend so you can see the labels on top of the map features.
Class Breaks maps

The Class Breaks option uses quantile classification to create graduated color maps. In the quantile classification method, each class contains the same number of features. A different color is applied to each category of values from whichever field in the database you specify. The steps outlined demonstrate how to create shaded polygon maps; the same technique is used to create graduated symbol sizes for a point theme.

1. Open the Theme Properties dialog.
2. Choose Class Breaks from the Classification Options.
3. Pick a Numeric field. This field contains the values that will be mapped. For the numeric field, ArcExplorer is limited to finding the first 2,000 unique values in your data set.
4. Choose the number of classes you want in your classification.
   - **Options:**
     - a. Click the Start and End color boxes to change the starting and ending colors for your color ramp.
     - b. Check the Remove Outline box if you want polygons drawn with no outline. (This is useful when you have many small polygon features.)
5. Click Apply to commit your changes or OK to commit the changes and close the Theme Properties dialog at the same time.

To remove classification from the active theme
Click the Clear Thematic Classification tool to return the theme to Single Symbol classification.

To highlight features from the legend
Once you’ve set up a Unique Values map, you can click a colored box in the legend to highlight the corresponding features on the map.

To clear highlighted features
Click the Clear Selection button to remove a highlighted feature from the map view. A highlighted feature remains on the map view, even after you turn the theme off, until you click the Clear Selection button.

To label a theme classified as Class Breaks
In order to label a theme that has been thematically classified, you must add the theme twice, once with its thematic classification and then again to label it.
1. Add that theme to your legend twice.
2. Set the second theme as a Label map. Uncheck the Draw Features box. Click OK.

Be sure the labeled theme is listed on top of the other theme in the legend so you can see the labels on top of the map features.
Label maps

The Standard Labels and No Overlapping Labels maps label features with a specified text field in the database. You have two options to create label maps: Standard Labels or No Overlapping Labels. Each option has its advantages depending on the type of data you are labeling and the cartography you require.

For Standard Labels maps, labels are placed according to the preferences you choose on the Theme Properties dialog. Standard Labels maps are generally suitable for large area features that do not require resolution for label placement problems such as crowding or overlapping. If you are displaying annotation features in ARC/INFO coverages or SDE layers, you can use the Standard option to specify an X-Offset and Y-Offset field for placing the annotation. Additionally, Standard Labels maps provide placement options: splined, fitted, flipped, and rotated.

Uncheck Allow Duplicates box to label features with the same name only once. The advantages of not allowing duplicates are most obvious for data such as street networks, where each segment of a street has a name field.

- Check Splined text for labels that follow the shape of its feature.
- Check Flip to change the orientation of a label.
- Check Fitted to spread a label across a feature.
- Choose a value from 0 to 359 if you wish to rotate the labels.

Click Apply to commit your changes or OK to commit the changes and close the Theme Properties dialog at the same time.

Creating a Standard Labels map

1. Open the Theme Properties dialog.
2. Click Standard Labels.
3. Choose a Text field.
4. Click Apply to commit your changes or OK to commit the changes and close the Theme Properties dialog at the same time.
5. Uncheck Allow Duplicates box to label features with the same name only once. The advantages of not allowing duplicates are most obvious for data such as street networks, where each segment of a street has a name field.

Options:

- Use the vertical and horizontal alignment options to control the label position relative to the center of the feature being labeled.
- Click the Font button to change the font, style, size, or color.
- For displaying annotation in ARC/INFO coverages or SDE layers, choose an X-Offset and Y-Offset field.
- Uncheck Draw features to see only the labels and not the features. This is useful when labeling over an identical theme with a thematic classification.
Creating a No Overlapping Labels Map

For No Overlapping Labels maps, ArcExplorer assesses the features being labeled and attempts to resolve cases where labels are crowded or overlapping. The No Overlapping Labels option is helpful for labeling compacted features such as street networks. Also, masking labels is only available on No Overlapping Labels maps.

1. Open the Theme Properties dialog.
2. Click No Overlapping Labels.
3. Choose a Text field.
   - **Options:**
     a. Click the Font button to change the font, style, size, or color.
     b. Choose a Label placement option.
     c. Uncheck Draw features to see only the labels and not the features. This is useful when labeling over an identical theme with a thematic classification.
     d. Uncheck Allow Duplicates box to label features with the same name only once. The advantages of not allowing duplicates are most obvious for data such as street networks, where each segment of a street has a name field.
     e. Check Mask labels and you can choose a mask color to be displayed under the label.
     f. Choose a Label Size or check Scale labels and choose a scaling factor.
4. Click Apply to commit your changes or OK to commit the changes and close the Theme Properties dialog at the same time.

To remove labeling from the active theme
Click the Clear Thematic Classification tool to return the theme to Single Symbol classification.

To label a theme classified as Unique Values or Class Breaks
In order to label a theme that has been thematically classified, you must add the theme twice, once with its thematic classification and then again to label it.
1. Add that theme to your legend twice.
2. Set the second theme as a Label map. Uncheck the Draw Features box. Click OK.

Be sure the labeled theme is listed on top of the other theme in the legend so you can see the labels on top of the map features.
So far in this book you’ve seen how to display your data in ArcExplorer. This chapter describes how to use ArcExplorer to query your data so you can get information. You can perform such queries in ArcExplorer by pointing at features on a map to identify them or finding which features meet certain criteria.

This chapter shows you how ArcExplorer gets information about features shown on a map.

**IN THIS CHAPTER**

- Identify features with the mouse
- Select features on a map according to their attributes
- Build query expressions with ArcExplorer software’s Query Builder
- Generate statistics
- Measure distances between features
Identifying features with the mouse

Suppose you are looking at a map of the world, and you want to get information about a particular city. To get information about one of the features on your map, use the Identify tool. When you click a feature with this tool, ArcExplorer displays the attributes of the feature in a dialog. You can use the Identify tool in local or WWW mode. The feature does not flash in www mode.

1. In the legend, click the name of the theme you wish to identify to make it active.
2. Click the Identify tool.
3. Click the feature you wish to identify. The feature you click flashes in the map view, and its attributes appear in the Identify Results dialog.

On the Identify Results panel, ArcExplorer reports the number of features found. If more than one feature was identified, you can see all the features that were found by using the drop-down functionality on the Feature list.

To drag and drop Identify Results

You can drag and drop the results of an Identify into any OLE-enabled application such as Microsoft Word or Excel. With the left mouse button, click one of the data fields listed in the Identify Results panel. Then, drag and drop into the OLE-enabled application of your choice.

In this chapter, look for the icon next to other ArcExplorer tools that are OLE-enabled.

Object Linking and Embedding. A set of integration standards to transfer and share information among client applications. A protocol that enables the creation of compound documents with embedded links to applications so that a user does not have to switch among applications in order to make revisions. This is useful for ArcExplorer as results from an Identify, Query, or Statistics can be dragged and dropped into such OLE enabled applications as Microsoft Word documents or Excel spreadsheets.
Finding features by name

You can use the Find tool to locate particular features from the themes in your map view. Find works by searching the theme or themes you specify for features with the value you specified. Only fields that have been defined as text strings, as opposed to numeric values, are searched. The Find tool works in Local mode only.

To search for features according to a numeric value, use the Query Builder described in the next section.

In the Find Features dialog

2 Enter name of what you want to find. You don’t need to enclose the text you specify in quotes. Find is case sensitive. Wild-card characters are not supported.

3 Choose a search type. Choose “Any Part of Field” if you want to enter only part of the search text. For example, if you are searching a theme of world countries, just typing Afgh would find Afghanistan.

4 Choose which theme or themes to search.

5 Click Find. ArcExplorer searches the features in the chosen themes to find features that meet the search criteria. ArcExplorer is limited to finding the first 500 features that meet the search criteria.
Finding features by building a query expression

A query expression is a precise definition of what you want to select. Building a query expression is a powerful way to select features because an expression can include multiple attributes, operators, and calculations.

In this example, you have a map of world cities and you want to find cities that are not capitals but have a population greater than 1,000,000.

1. Click the name of the theme you wish to query to make it active.
2. Click the Query tool.
3. From the list of fields, click CAPITAL to enter it into the expression.
4. Click the Equal button to enter the = operator into the expression.
5. Click N from the Sample Values list.
6. Click the And button to indicate that both parts of the expression must be true.
7. From the list of fields, click POPULATION.
8. Click the Greater Than button.
9. Type 1,000,000 into the expression.
10. Click the Execute button. Features that meet the query definition appear in the Query Results panel. The Query Builder is limited to finding only the first 2,000 records that meet the search criteria.

Queries on SDE Themes.
Due to the potentially large size of SDE layers, Sample Values are not listed for SDE themes.
Working with Query Results

- Choose another field for the Display Field and click Execute to see a different field displayed under the Query Results.

- Or check Show All Attributes to see all the fields associated with the found feature(s).

- Click Highlight Results to highlight all the features in the map view that met the query. Use Zoom to Results to zoom in on just those features.

- Pick a single record from the results panel and press Highlight under Selected Record to see the feature. Also, Pan or Zoom to see that feature in the map view.

- Sort the query results according to a text field by pressing the title of that column. Sorting only works on alphanumeric fields; if you sort a numeric field, you’ll get the wrong results.

- Click the Save Results button above the Query Results panel to save the results of the query to an ASCII text file.

  or

- Drag and drop the results of a query into any OLE-enabled application such as Microsoft Word or Excel. Click an entry listed in the Query results. Then, drag and drop the results into the OLE-enabled application of your choice.

Here is an example of query results after they have been dragged to an ASCII text file.

Query Expression:
CAPITAL = ‘N’ and POPULATION >1000000

NAME|COUNTRY|POPULATION|CAPITAL
Ahmadabad|India|2400000|N
Aleppo|Syria|1216000|N
Alexandria|Egypt|3350000|N
Amsterdam|Netherlands|1860000|N
Anshan|China|1300000|N
Antwerpen|Belgium|1100000|N
Atlanta|US|1962500|N

- Clear the Query Results panel by clicking the Clear Results button.
More examples illustrating the syntax of query expressions

Strings such as names are always single quoted in query expressions. Strings are case sensitive, so if a string field’s value is ‘Albania’, you can select this record with

   NAME = ‘Albania’

When querying strings, you can use % as a single or multiple character wild card in conjunction with the like operator. For example, to select ‘Luxembourg’ you could use this expression:

   NAME like ‘Lux%’

Queries can compare the values of two fields. For example, to find all the counties whose population declined from 1990 to 1996:

   POP1990 > POP1996

Use the And operator when both expressions must be true. For example, to find features with an area of between 42,000 and 71,000:

   AREA >= 42000 and AREA <= 71000

Use the Or operator when at least one expression must be true:

   SALES > 20000 or CURRENT_ORDERS > 20000
Generating summary statistics

Once you’ve selected a set of features with the Query Builder, you can also generate summary statistics on a certain field in the database for just those selected records. Statistics are generated for selected features or the full database.

1. In the Query Builder, press the Statistics button.

2. Choose the field for which you want to generate statistics from the list.

3. By default, ArcExplorer generates statistics for all records in the database; check the Use Query Results box if you want statistics on just the query results.

The summary statistics appear in the Query Results panel.

To save summary statistics to an ASCII file

Click the Save Results button above the Query Results panel to create a new file. Name the new file and click Save. The file can be opened in a spreadsheet or word processing program to create a report or conduct further analysis.

or

Drag and drop the statistics results into any OLE-enabled application such as Microsoft Word or Excel. Click an entry listed in the Query results. Then, drag and drop the results into the OLE-enabled application of your choice.
Using the measure tool

Use the measure tool to measure distances on your map. First, use the measure tool to specify a measurement unit. You can measure distances on your map in feet (ft), miles (mi), meters (m), or kilometers (km).

1. Click the Measure tool and choose a measurement unit from the detachable menu.

2. On the map view, click and drag to draw a line representing the distance you wish to measure.

   ![Map view with measure tool](image)

   The segment and total length you measured is displayed in the status panel at the top left of the map view.

   To stop measuring and clear the measurements, double-click in the map view. After you double-click, the total length appears in the lower left corner on the status bar.
Addresses are probably the most commonly used form of geographic data. Geocoding is the process by which you add point locations defined by street addresses, or other address information, to your map. It’s the computer equivalent of pushing pins into a street map on your wall. Address matching is a type of geocoding. You can do single record address matching using ArcExplorer.

IN THIS CHAPTER

- How geocoding and address matching work
- What the requirements are for street files
- How to prepare a street theme for address matching
- How to perform interactive address matching
How address matching works

Address matching is a process that compares an address to a street database with address ranges to determine whether the address falls on that street, and if so, which side of the street, and approximately at what location along the street. To match addresses, ArcExplorer compares components of addresses that you enter and the feature data source. ArcExplorer then uses certain standards to determine whether addresses match.

Address matching involves interpolation; it is not an exact science. Address matching is the process of calculating geographic positions from addresses by interpolating from the from-address and to-address of a street segment, taking into account even and odd address numbering.

Finding an address

Street files are comprised of digitized centerlines with attributes coded for the left and right sides and from-and to-points. The left and right sides are relative to the direction from the from-point to the to-point.

Besides returning a position, address matching returns standardized address values for house numbers, street names, prefixes and suffixes, house numbers, and ZIP Codes.

Address ranges are stored with each street segment. Four numeric values are stored: Left-From, Right-From, Left-To, and Right-To. In the United States, addresses are even numbered on one side and odd numbered on the other.
What themes can be address matched

A database can be completely devoid of spatial information such as latitude and longitude values or map coordinates, yet be rich in postal geography.

Street files for address matching

To perform address matching, you must have a street file that contains street centerline segments with information about addresses. The street file can be a shapefile or an ARC/INFO coverage. There are three basic requirements for a street file to be suitable for address matching:

1. The street file should comprise street centerline segments that form clean junctions at street intersections. There should not be any features in a street file besides street centerline segments.

2. Each street centerline segment should be attributed at minimum with five fields: a street name, a beginning address on the left side of the street, a beginning address on the right side, an ending address on the left side, and an ending address on the right side.

3. The right and left address pairs must be respectively even and odd numbered. That is, the to- and from-addresses for each side must be even or odd numbered. The left and right sides must complement each other.

Obviously, the left and right sides of a road are relative to the direction you travel on a road. Street files follow a convention that left and right are determined by the direction from the from-point to the to-point in the street file.

Address matching in ArcExplorer is designed for use in the United States. Address matching may work in other international locales only if you have access to street files that conform to the requirements listed above.

Also, address matching in ArcExplorer is suitable for moderately sized street files, such as one spanning a city or county, but it is not designed for very large national street files such as one containing all of the streets in the United States.

Possible street file sources

In the United States, you can use shapefiles converted from TIGER® (Topologically Integrated and Geographically Encoded Referencing system) files, which are provided at a nominal cost by the Bureau of the Census. You can also use other street files provided by commercial vendors who have either enhanced and updated the TIGER files or built detailed street files from scratch. It is usually more cost-effective to utilize commercially available street files than to attempt to build your own.

ESRI provides street data for the United States through ArcData Online at www.esri.com/data/online/.
Preparing a theme for address matching

Before you can begin address matching, you must first set the properties for the street file you wish to address match against.

WHAT YOU NEED

• A street theme that meets the requirements for a street file.

1. Make the street theme you wish to address match against active.

2. From the Theme menu, choose Address Matcher Properties.

3. In the Address Matcher Properties dialog, you must specify the required input fields.

4. Click OK to make the theme matchable.

The required fields for the Address Matcher have default values.

StreetField has a default value of NAME.
LeftFromField has a default value of L_F_ADD.
LeftToField has a default value of L_T_ADD.
RightFromField has a default value of R_F_ADD.
RightToField has a default value of R_T_ADD.

The Address Matcher also has predefined fields with default values.

LeftZipField has a default value of ZIPL.
PrefixDirectionField has a default value of PREFIX.
RightZipField has a default value of ZIPR.
StreetTypeField has a default value of TYPE.
SuffixDirectionField has a default value of SUFFIX.
Locating a street address or intersection

WHAT YOU NEED

- A street theme that meets the requirements for a street file.
- A street theme that has been prepared for address matching through the Address Matcher Properties dialog.

1. Make the street theme that you are address matching against active.

2. Click the Address Matcher button.

3. On the Address Matching dialog, choose whether you will enter an address or an intersection.

4. Type an address or intersection and cross street, city, state, and ZIP Code for the location you want to address match. Enter as much information as you have available to ensure the most accurate address match.

5. Click the Match button. ArcExplorer geocodes the address and, if it can find it, locates it on your map with a point. The map view pans and zooms to the location of the matched address.
You’ve displayed your data in the map view. You’ve chosen the symbology you want to use. This chapter outlines how to print a map, save your map as an image, and save your ArcExplorer project.

Your map is perfect. And now you want to print it out with a title, scale bar, legend, north arrow, descriptive text, and other graphics such as a border. You can do this with ArcExplorer software’s standard map template.
Printing a map

ArcExplorer provides a simple map layout in landscape (horizontal) format. The layout includes a north arrow, legend, title text, date, map view, and an optional scale bar (the scale bar must be present in the view in order for it to appear on the final layout). If the themes or classification categories cannot fit on one page, the legend prints onto a second or more pages.

If you want to add customized legends, graphics, additional text, or multiple views to your maps, you’ll need software like ESRI’s ArcView GIS to do the job. The print function works with any Windows supported printer.

Use the steps outlined in Chapter 5 of this book to symbolize your data. Then use the Pan and Zoom tools so that the display in the map view looks the way you want it to look on paper.

1. Click the Print tool.
2. Enter a title for your map.
3. Your map will print to your default printer. You can choose Print Setup properties to change printers or to access other printer options.
4. Click Print.

If the legend for your map is too long, it prints onto a second page. ArcExplorer has a two-page limit for the legend. If your legend exceeds two pages, you may want to reconsider the symbolization of your map. See Chapter 5, Symbolizing Data for more details.
Copying map views for use in other applications

You may want to copy the image of a map view for use in another Windows application (like a word processor or a drawing program). ArcExplorer makes it easy to create a graphic image of your view.

Use the steps outlined in Chapter 5 of this book to symbolize your data. Then use the Pan and Zoom tools so that the display in the map view looks the way you want it to look on paper.

1. From the Edit menu, or right-click in the map view, click the Copy to Clipboard and Copy to File commands.

2. Choose Copy to Clipboard if you plan to go into another Windows program and paste the image in directly. Choose Copy to File if you want to create a file to use anytime in the future. If you do this, ArcExplorer prompts you to name the new file.

Choose the BMP (Windows bit map) option for raster data, images. Choose the EMF (Enhanced Metafile) option if the map has only vector data, lines, areas, or points.
Saving your work in ArcExplorer

ArcExplorer saves projects in files with an .aep extension. The map display properties, whether themes are turned on or off, the map extent, view properties, any classification or labels applied to themes, and any scale factors you may have set are saved. When you create an .aep file, you’re not changing or altering the base data in any way.

1. Choose Save Project or Save As from the File menu, or click the Save tool [ ].

2. If necessary, name your ArcExplorer project.

3. Click OK.

Moving data. When opening a project, ArcExplorer will not prompt you for any data that may have moved since you last saved the project. Instead, it will warn you with a message that there was an error trying to open a theme and then it will restore the view with the themes that it could find.
You have created an ArcExplorer project. And now you would like to share your project with other ArcExplorer users. With some edits, your project can be made portable so that your project can be opened on any machine where ArcExplorer is installed.

The map properties and data path names for an ArcExplorer project are saved in one file with an .aep extension.

• About the difference between hard-coded and relative data path names
• How to create relative path names to your data
• How to zip up your project and data
Creating relative path names

The following steps outline how to edit the data path names in .aep files from hard-coded to relative path names. To illustrate the difference between hard-coded and relative path names, let’s say you have data in a folder called “trails” stored in the E:\ESRI\DATA\trails directory of your computer. When ArcExplorer saves, the data path names are hard coded into the project file as WORKSPACE=E:\ESRI\DATA\trails. Once your project is distributed, the data could be stored anywhere on that new computer. You want to create relative path names to your data by replacing WORKSPACE=E:\ESRI\DATA\trails with WORKSPACE=\trails. After the path names have been changed, you can zip up the project file and accompanying data.

Separate instructions apply if you are editing path names to ArcView GIS shapefiles or images as opposed to ARC/INFO coverages. You cannot create relative path names for data stored in an SDE database.

**WHAT YOU NEED**

- An ArcExplorer project (file with .aep extension).

For shapefiles or images

1. Using a text editor or word processing program, open the .aep file you want to edit.

2. Locate all the map layers and their associated path names. The easiest way to do this is to use the Find functionality on your text editor. The path names are on the first line after the [MAPLAYERx] designation. Use the search string [MAPLAYER] then scroll down to the next line that begins with WORKSPACE=.

An example of the critical text from an .aep file is

[MAPLAYER4] WORKSPACE=E:\ESRI\DATA\trails

3. Change all the data path names to relative path names.

In this example your data are stored in the DATA directory in folders called “trails,” “counties,” “rivers,” and “schools.”

WORKSPACE=E:\ESRI\DATA\trails\counties\rivers\schools

As long as the .aep file is stored in the DATA directory, you can edit the path name in the .aep file to read

WORKSPACE=\trails

If you store the .aep file in the same directory as the data themselves, you can edit the path name to read

WORKSPACE=\n
In this case, the path name contains only a single slash.

4. Save the project file. Choose All Files as the Save As type to avoid putting an extra extension such as .doc or .txt on the project file.

**Losing relative path names**

If the ArcExplorer project that you created relative path names for is opened and saved using ArcExplorer software’s Save Project or Save As commands, the data path names will be hard coded again, removing their relative status.
For ARC/INFO coverages

1. Save your .aep file in the same directory as your coverages.

2. Using a text editor or word processing program, open the .aep file you want to edit.

3. Locate all the map layers and their associated path names. The easiest way to do this is to use the Find functionality on your text editor. The path names are on the first line after the [MAPLAYERx] designation. Use the search string [MAPLAYER] then scroll down to the next line that begins with WORKSPACE=.

Assume that your data are stored in the c:\temp\arcinfo\usa_coverages directory. Perhaps you have a series of workspaces in the usa_coverages directory: usa, waters, roads, etc. When you save your .aep file in the usa_coverages directory, the path names will look like this:

[MAPLAYER2]
WORKSPACE=[arc]c:\temp\arcinfo\usa coverages
BASE=1,D:\usa coverages\usa\ state.pat,usa.patstate

4. Change all the path names in your .aep file to relative path names.

[MAPLAYER2]
WORKSPACE=\usa
BASE=1,state.pat,usa.patstate

Notice that you had to delete everything (including [arc]) from the path name and add \usa to the WORKSPACE= line. Also, you must delete D:\usa coverages\usa\ from the BASE= line.

5. Save the project file. Choose All Files as the Save As type to avoid putting an extra extension such as .doc or .txt on the project file.

Losing relative path names
If the ArcExplorer project that you created relative path names for is opened and saved using ArcExplorer software’s Save Project or Save As commands, the data path names will be hard coded again, removing their relative status.
Zipping up your ArcExplorer project and data

In your Windows Explorer, rename your ArcExplorer project to default.aep. A project file named default.aep, which is part of a ZIP archive, is opened when the ZIP archive is added to ArcExplorer.

Zip up the default.aep file and all the related data.

The ZIP archive can now be dragged and dropped into ArcExplorer.
As you become familiar with ArcExplorer, you may want to do some customization to the ArcExplorer window to suit your project. ArcExplorer contains a core set of functionality. You can customize the existing functionality of ArcExplorer. For example, you may only need a particular set of ArcExplorer software’s tools. You can close a tool bar that you do not use or create buttons for menu choices you use most often. Or the menu bar or tool bars can be moved or undocked to satisfy your personal preferences. You cannot customize ArcExplorer to add new functionality.
ArcExplorer tool bars

Standard

Map Tools

Theme Tools

ArcExplorer WWW Tools
Moving and undocking the menu bar and tool bars

The menu bar and tool bars are docking elements that can be moved or undocked to float anywhere on your desktop. As you are making changes to the menu and tool bars, remember, at anytime you can choose to restore the original ArcExplorer interface. To do this, choose Reset ArcExplorer ToolBar from the View menu.

1. Click the menu or tool bar you wish to move on the double vertical lines located on the right side of the bar.

2. Drag it to reposition it. You can undock it so it is floating anywhere on the desktop.

The Direction and Measure tools have a detachable menu that you can move or undock in the ArcExplorer window.

You can return a menu or tool bar to its original position by double-clicking on it.
Customizing the tool bars

You can create new tool bars using the ArcExplorer customization dialog. Although you can add new tool bars, you cannot add new buttons to the original ArcExplorer tool bars.

1. Right-click the gray menu or tool bar to open the ArcExplorer customization dialog. Choose Customize.

2. Click the Toolbars tab.

3. Click New and name the new tool bar. The new tool bar appears in the ArcExplorer window.

4. Click the Commands tab.

5. Click a category to see the associated commands.

6. Now you can drag and drop a command onto the new tool bar you just created.

7. When you are done, click Close to close the Customize dialog and activate the tool bar.

You can now widen the tool bar, reposition it in the ArcExplorer window, or dock it with the other tool bars.

Go back to the Customize dialog to rename or delete a newly added tool bar.
Customizing the menu bar

You can add a new menu using the ArcExplorer customization dialog. Or you can add a choice to an original ArcExplorer menu.

1. Open the ArcExplorer customization dialog.

2. Click the Commands tab.

3. Click a category to see the associated commands.

4. Select a command.

5. Now you can drag and drop the command onto the menu bar to create a new menu. Or you can drag and drop a command onto an existing menu to add it as a new menu choice. Once a command is added to a menu, it can be dragged and repositioned on the menu.

6. Click Close to close the Customize dialog. The new menu or menu choice is now ready to use.

Deleting a menu or menu choice
If you would like to delete a menu or menu choice that you have added, first open the ArcExplorer customization dialog. Then drag the menu or choice you wish to delete out of the ArcExplorer window.

Maintaining changes to the interface
ArcExplorer automatically maintains customization of the interface, regardless of whether or not you saved the ArcExplorer project.

Restoring the original ArcExplorer interface
You can restore the original ArcExplorer interface settings by choosing Reset ArcExplorer ToolBar from the View menu.
Appendix

If you can’t find the answer to your question here, please refer to the ESRI ArcExplorer Web site at www.esri.com/arcexplorer for an updated Troubleshooting and Frequently Asked Questions section, discussion forums, and other late-breaking information.

Troubleshooting guide

I can’t download the software.
ArcExplorer is available for free downloads from the ESRI ArcExplorer Web site. You may have trouble downloading the installation file because your Internet Service Provider (ISP) limits the amount of data you can download or your connection to the Internet is slow (28.8 kbps modems may require an hour or more to download the software). If you have difficulty downloading the software, you can obtain ArcExplorer on CD–ROM by calling ESRI at 1-800-GIS-XPRT.

I can’t install the software.
First, make sure that your system meets the requirements listed under System Requirements in this document. Second, during the install, files are put in the %TEMP% directory for utility purposes. A %TEMP% environment variable must be set and the %TEMP% directory should be writeable. To check that a %TEMP% variable is set, from the Start menu, go to Settings to open your Control Panel. Choose System and then choose Environment. There should be a TEMP or TMP variable listed under User Variables. If not, set one at this time and restart your computer.

How do I label a map that has a value or class break map?
To label a theme that’s been classified as unique value or class breaks, add that theme to your legend twice. Set up one as the classified theme and the other as the label theme. For the labeled theme, uncheck the Draw Features box, and click Apply on the Theme Properties dialog. Be sure the labeled theme is listed on top of the other theme in the legend so you can see the labels on top of the map features. You can also set the maximum scale factor so that the labels will only appear when the user zooms in to a certain scale. This helps to reduce cluttered labels on the map when zoomed to a small scale.

How can I make the screen stop redrawing if it is taking too long?
In the Map Display Properties dialog, enable the Escape key to interrupt the screen redraw. See Chapter 4.

ArcExplorer can’t find some data because the data have moved. Is there a way to prevent this?
Yes. Set up relative path names in your .aep file. See Chapter 9.
Frequently Asked Questions

What other Web sites can I view and download data from using ArcExplorer?
ArcExplorer software’s Web integration tools allow you to view and download data from Web sites using ESRI MapObjects Internet Map Server (IMS) Version 2.0 technology. Visit ESRI’s ArcExplorer home page at www.esri.com/arcexplorer for news on Web sites using ESRI MapObjects IMS technology. If you’d like information about how you can serve maps and data, visit ESRI’s MapObjects IMS home page at www.esri.com/mapobjects.

How are the data delivered?
The data are extracted by the server, compressed, and then shipped via the Internet to your ArcExplorer client. The vector data are restored in standard shapefile format. The image data are restored in bit map format.

In my class break map, why does my first class have -99 as a value?
Sometimes geographic data are incomplete. For example, a GIS database may include political boundaries for countries, but it may not have complete attribute information for every feature represented. As a result, database developers must use a code for missing information. These developers often use -99 as this code for “no data.”

Does ArcExplorer support drag and drop file functionality?
Yes. ArcExplorer allows you to grab data from any Windows directory and drop it into the ArcExplorer map view to add it as a theme.

Can I move the menu and tool bars?
Yes. See Chapter 10.

Can I have more than one ArcExplorer project open concurrently?
Yes, open as many new or saved ArcExplorer projects as you wish. A new ArcExplorer application window will appear for each session.

What are the supported image file formats?
See this appendix, Image formats, for a listing of image formats you can display with ArcExplorer.

How can I delete a Web site that I added as an AEWeb Favorite?
Open the AEWeb Favorites dialog by clicking the AEWeb Favorites button . Select the Web site you wish to delete and click the Delete button .

How can I view images that are in .EMF format?
EMF is an enhanced metafile format. Images in the EMF format are used to display vector data, lines, points, and areas. These images can be inserted as pictures into applications that support the EMF image format. For example, Microsoft’s Office 97 suite supports EMF format images.
How is ArcExplorer built?
ArcExplorer is built using ESRI’s MapObjects software, a powerful collection of GIS and mapping components for application developers. MapObjects allows people to build their own custom GIS applications or add active mapping and geography to spreadsheets, charts, documents, and more.

Check out www.esri.com/mapobjects for more information or call 1-800-GIS-XPRT.

Does ArcExplorer support ARC/INFO annotation coverages?
Yes. ArcExplorer adds coverages with annotation as line themes. Add the annotation theme. Open the Theme Properties dialog and choose Labels-Standard to label the theme using the TEXT field name. Choose an X-Offset and Y-Offset field if necessary. Uncheck “Draw Features” so that the lines don’t draw.

Can I use ESRI .e00 export files for ARC/INFO coverages?
An .e00 (“E-zero-zero”) file is an ARC/INFO coverage converted into an ASCII text file intended for exchange between two ARC/INFO systems on different platforms. They are not intended for compression, but they have become popular as exchange files. In order to convert an .e00 file to an ARC/INFO coverage or ArcView GIS shapefile, you must have ARC/INFO or the import software distributed with ArcView GIS.

Are the spatial data I add to my map saved in my project?
No. An ArcExplorer project file doesn’t contain the spatial data that you add to the maps in that project. Instead, a project stores references to the location of these data sources on disk. In this way, the same data can be used in any number of projects without duplication, and if these data change, the updates will be reflected in all the projects that reference these data.

Can I include project (.aep) files with the data I publish on CD–ROM?
Yes. If you decide to publish your data on CD–ROM and you choose to use ArcExplorer as your data browser, you must use relative path names to your data. See Chapter 9, Distributing Your Application.

My organization wants to publish our GIS data on CD–ROM. Can we use ArcExplorer as the data browser?
Yes. You can use ArcExplorer as a data browser provided you agree to follow ESRI license requirements. Ultimately, ESRI wants to make it easy for you to include ArcExplorer with your data and the license reflects that. Refer to the ArcExplorer license included with the installation in your ArcExplorer folder.
Can I customize ArcExplorer by adding new functionality?
No. ArcExplorer is a data browsing program, not a development tool. However, ESRI staff can create similar applications quickly, adding or removing the tools you need. ESRI can also teach you how to create applications like ArcExplorer on your own.

To contract with ESRI for custom programming support, contact ESRI Implementation Services at 909-793-2853 (telephone), 909-307-3014 (fax), or E-mail at arcexp@esri.com, or write to Implementation Services, 380 New York Street, Redlands, CA 92373-8100.

To learn more about ESRI training courses, contact the ESRI Learning Center at 909-793-2853 (telephone), 909-335-8233 (fax), or visit the ESRI Educational Services home page at www.esri.com/training.
Image formats

The following image formats can be used with ArcExplorer

Windows bit map—*.bmp, *.dib
TIFF (Tag Image File Format)—*.tif, *.tff, *.tiff
ERDAS—*.gis, *.lan
BIL (Band interleaved by line) multiband images—*.bil
BIP (Band interleaved by pixel) multiband images—*.bip
BSQ (Band sequential) multiband images—*.bsq
IMPELL RLC (Run-length compressed) files—*.rlc
Sun Rasterfiles—*.rs, *.ras; *.sun

How the TIFF image is supported
Tag image file format (TIFF) has widespread use in the desktop publishing world. It serves as an interface to several scanners and graphic arts packages. TIFF supports black-and-white, grayscale, pseudocolor, and true color images, all of which can be stored in a compressed or uncompressed format. The following types of TIFF images can be displayed:

Single band black-and-white (1 bit), grayscale (4, 8, 16, 24, or 32 bits), and pseudocolor (4, 8, and 16 bits) images.

Multiband images with 8 bits per band. Both planar configurations are supported. There is no restriction on the number of bands in the image.

The following compression schemes are supported:

CCITT Group 4 (TIFF Compression Scheme 4) for black-and-white data
CCITT Group 3, 1-D encoding (TIFF Compression Scheme 2) for black-and-white data
PackBits

TIFF 6.0 is not supported.